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   Abstract 

Photography stands as a pivotal documentation tool in the realm of archaeological studies. 

Within the context of archaeological research methods such as excavation and survey, it is 

crucial to capture the overall view of studies and discoveries through images. The 

technology and techniques of photography utilized in archaeological endeavors have been 

gradually improving. The rapid progress in technology equips researchers with exceptional 

tools to document their finds. However, merely possessing the equipment is not sufficient 

to leverage the benefits of contemporary technology. A solid understanding of 

photography gear and especially its methodologies greatly streamlines the documentation 

process. In this light, a range of photographic methods can be employed at any excavation 

site and at different stages, given that one has access to at least a semi-professional camera. 

This article delves into the three fundamental techniques in  archaeological photography. 

‘Panoramic photography technique,' the 'HDR photography technique,' and the 'focus 

stacking technique'. The primary aim of this research is to elucidate how to capture the 

images necessary for an archaeological project in the most precise and effective manner. 

To successfully implement these techniques, one must possess basically a competent level 

of camera and Photoshop software. With a certain amount of practice, they can readily 

apply the technical insights outlined in this study. This article concludes that photography, 

as a fundamental method used in archaeological studies, has the potential to open up new 

collaborative projects for both photographers, academics and archaeologists.   

 

   Keywords: Photograph, Archaeological Photography, Photography Techniques. 

   

 Öz 

Fotoğrafçılık, arkeolojik çalışmalar alanında temel bir belgeleme aracı olarak öne 

çıkmaktadır. Kazı ve yüzey araştırması gibi arkeolojik araştırma yöntemleri bağlamında, 

çalışmaların ve keşiflerin genel görünümünü görüntüler aracılığıyla yakalamak çok 

önemlidir. Arkeolojik çalışmalarda kullanılan fotoğrafçılık teknolojisi ve teknikleri 

giderek gelişmektedir. Teknolojideki hızlı ilerleme, araştırmacılara buluntularını 

belgelemek için üstün araçlarla donatmaktadır. Ancak, yalnızca ekipmana sahip olmak, 

çağdaş teknolojinin faydalarından yararlanmak için yeterli değildir. Fotoğraf 

ekipmanlarına ve özellikle yöntemlerine dair sağlam bir anlayış, belgelemeye yönelik 

süreci büyük ölçüde kolaylaştırır. Bu bağlamda, en azından yarı profesyonel bir kameraya 

erişim sağlandığı takdirde, herhangi bir kazı alanında ve farklı aşamalarda çeşitli 

fotoğrafik yöntemler kullanılabilir. Bu makale, arkeolojik fotoğrafçılıktaki üç temel 

tekniği ele almaktadır:  'panoramik fotoğrafçılık tekniği', 'HDR fotoğrafçılık tekniği' ve 

'odak yığma tekniği'. Bu araştırmanın temel amacı, arkeolojik bir proje için gerekli olan 

görüntülerin en hassas ve etkili şekilde nasıl elde edilebileceğini açıklığa kavuşturmaktır. 

Bu teknikleri başarılı bir şekilde uygulamak için, kişinin yeterli düzeyde fotoğraf makinesi 

ve Photoshop yazılımı bilgisine sahip olması gerekir. Belli bir süre pratik yaptıktan sonar, 

bu çalışmada özetlenen teknik bilgileri kolaylıkla uygulayabilirler. Bu makale, arkeolojik 

çalışmalarda kullanılan temel bir yöntem olan fotoğrafçılığın; fotoğrafçılar, 

akademisyenler ve arkeologlar için yeni işbirliği projelerinin önünü açacak bir potansiyele 

sahip olduğu sonucuna varmaktadır. 

 

   Anahtar Kelimeler: Fotoğraf, Arkeolojik Fotoğrafçılık, Fotoğrafçılık Teknikleri. 

 

* The article is derived from the Master’s thesis titled “Photography Techniques in Cave 

Excavations in Archaeology: The Keçe Cave Example,” written by Savaş Akkaş (Aksaray 

University, Thesis No: 961977)
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INTRODUCTION  

Following its invention, the camera was swiftly embraced and utilized in archaeology. The technique of 

capturing photographic images in the field was first attributed to R. Lepsius during an archaeological 

expedition in Egypt from 1842 to 1845. Nonetheless, the most significant contribution to archaeological 

photography comes from M. Tranchand's collection of images taken during V. Place's excavations in 

Assyria between 1852 and 1855 (Figure 1). Another notable use of photography was undertaken by 

Alexander Conze at the archaeological sites in 1872. Instead of relying on lithographs or engravings 

derived from photographic images, Conze produced the first documentation using actual photographs 

which is often considered the first modern archaeological record, during his work at Samothrace. The 

photographs taken by Conze at Samothrace, presented below, shows a meter beside the arch, indicating 

the height of the object, while the well-chosen angle provides insight into its depth (Figure 2). The 

images here also capture the stones and other architectural elements of the site in detail (Dorrell, 1994, 

p. 3-5).  

                              
Figure 1. Khorsabad Gate. M. Tranchand1852-1855      Figure 2. The arched structure in Samothrace 

                       (Dorrell, 1994, p. 3).                                                       (Dorrell, 1994, p. 5). 

 

A key publication detailing the essential technical aspects of photography in archaeology is Photography 

for Archaeologists by M.B. Cookson, with a preface by Mortimer Wheeler (Cookson, 1954). This book 

has been instrumental in laying out the foundational principles of archaeological photography. Another 

significant work regarding photographic techniques in archaeology is Photography in Archaeology and 

Conservation by Peter Dorrell (1994). The insights provided in these two books continue to hold 

relevance today. Reviewing literature on this subject in our country reveals that investigations into 

archaeological photography are particularly manifest in postgraduate theses. For example, Bekir 

Köşker's (2002) thesis titled “Arkeoloji`de Fotoğraf (Photography in Archaeology)”, completed in 2002 

under the supervision of Prof. Dr. Sabit Kalfagil, serves as a noteworthy example. Other examples 

include Nevin Azakoğlu's (2006) master's thesis, completed in 2006 and supervised by Prof. Dr. 

Barbaros Gürsel, titled “Tarihi Eserlerin Fotoğraflanması Erken Fotoğrafçılık Dönemi: 1839-1899 

(Photography of Historical Artifacts Early Photography Period: 1839-1899)”, Ayhan Özener's (2006) 

master's thesis titled “Arkeoloji Biliminde Fotoğraf Teknikleri (Photography Techniques in 

Archaeology)” supervised by Assoc. Prof. Dr. Göksel Sazcı, and Burcu Böcekler's (2007) master's 

thesis, supervised by Prof. Dr. Simber Eskier, titled “Fotoğraf-Arkeoloji İlişkisi ve Çağdaş Fotoğraf 

Sanatında Temsili (The Relationship Between Photography and Archaeology and its Representation in 

Contemporary Photographic Art)”. 

 

Following these contributions, only a small number of further postgraduate research has been undertaken 

regarding archaeological photography. One such article is Photography and Archaeology: The 

Photographic Journey of Urne 40- Fotoğraf ve Arkeoloji: Urne 40’ın Fotoğrafik Yolculuğu by Dr. Savaş 

Onur Şen (2023). As this article proves, given the rapid advancements in photographic tools and 

methodologies, producing updated publications on photography in archaeology would prove 

advantageous for the discipline. 
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In archaeological inquiries, the adoption of cameras has mainly replaced laborious techniques like 

drawing, and it has thereby reduced the time required for documentation tasks and enhanced the 

reproducibility and permanence of records. Technological progress in camera miniaturization and 

compactness, coupled with their increased affordability, has rendered photography one of the most 

crucial tools for documentation in modern archaeology. The rise and swift progression of digital 

technology have further amplified the utility of photography. While digitalization has made photography 

easier, it has also introduced certain challenges. The primary challenge lies in accurately representing 

the existing archaeological finds, while another challenge concerns archiving of the documentation. 

 

This study aims to elucidate both the theoretical and practical facets of photography in archaeology, 

drawing examples from the Keçe Cave excavation. This research aspires to equip an archaeologist 

engaged in any excavation or surface survey with the knowledge to capture the most effective 

photographs. The selection of Keçe Cave as the focal point is justified by the presence of diverse 

elements both inside and outside the cave, such as excavation sites, rock paintings, rock-cut tomb, along 

with a rich variety of finds (including stone, ceramic, bone, metal, glass, and decorative artifacts). The 

fact that materials spanning nearly all archaeological periods exist within a single excavation site 

enhances the breadth and significance of this study. Furthermore, from a photographic perspective, the 

presence of both indoor and outdoor areas, allows for the use of both natural and artificial light, and that 

of fragmented shadows in the outdoor area enables the use of HDR techniques. Furthermore, the use of 

Focus Stacking techniques for some of the finds, and the cave's location give the opportunity to use 

Panoramic techniques. All in all, these can be counted among the main reasons for the spatial selection 

of this study. Active involvement in the Keçe Cave excavations for photography purposes took place in 

2023 and 2024 including both field and artifact photography. Prior to engaging in the excavations, a 

methodical approach for archaeological sites and materials was determined, and photography techniques 

were executed with this consistent methodology. Practical and cost-effective tools and equipment were 

acquired for both field and artifact photography. Before capturing images in the field, the most 

appropriate time frames for each area across different locations were identified, and photography 

occurred within these time intervals. Two distinct techniques were employed in the field photography 

to achieve optimal results. The initial method utilized is panoramic photography which was prominently 

favored to display the wall murals and the surrounding area of the cave. Another method incorporated 

is HDR photography. This technique was specifically applied to capture images in Area C, positioned 

right in front of the cave where the 2024 excavations took place. Since the images of the artifacts were 

taken indoors, artificial lighting was employed which facilitated taking photographs at any hour of the 

day. A studio-like setting was established by arranging the backdrop, lighting equipment, and camera. 

The focus stacking method was particularly implemented for artifacts that presented focusing 

challenges. 

  

Prior to exploring the intricacies of the photographic methods central to this study, it would be beneficial 

to briefly outline the Keçe Cave excavation site where this research was carried out.  

 

KEÇE CAVE 

Keçe Cave is situated in the village of Keçemağara within the Elbistan district of Kahramanmaraş 

province. Located roughly 40 km north of the Elbistan district center, its elevation reaches 1734 meters 

above sea level (Yaman, 2020, p. 86). To the east of the cave lies the Beşpınar Mountains (2093 m), 

which stretch for about 3 km and delineate the border with Malatya province, while the Hezanlı 

Mountains (2283 m) are positioned approximately 7 km to the north/northeast and mark the boundary 

of Sivas province. Such geographical attributes render the cave's region adjacent to the borders of three 

provinces (Kahramanmaraş, Malatya, Sivas) as well as three distinct geographical areas (Mediterranean, 

Eastern Anatolia, Central Anatolia) (Yaman, 2023, p. 62).  

 

The first archaeologist to note the presence of Keçe Cave was Prof. Dr. İsmail Kılıç Kökten (1904-

1974). He discovered the cave during his archaeological studies in Kahramanmaraş in 1959 however, 

he did not undertake any excavations at the site (1960, p. 46). Later in 2012, surveys along the Afşin-

Elbistan route identified recorded archaeological artifacts in and around Keçe Cave. These findings 

include lithic tools attributed to the Paleolithic Age, as well as artifacts assumed to originate from the 
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Early Bronze Age and the Roman Period. Another significant aspect of the site is the presence of 

prehistoric paintings located within one of the smaller caves in the eastern area (Yaman, 2019). 

Excavations in the site started in 2015 to reveal the significance of Keçe Cave and to uncover its 

archaeological potential for the region. Excavations at Keçe Cave are still ongoing both within the cave 

and on the terrace section outside it. The assemblages of artifacts that are found just beneath the surface 

layer include chipped stone implements, animal bones and bone tools, ceramics, metal objects, glass 

items, and coins  (2023, p. 67-71). The excavation work is currently carried out by a team of 

archaeologists and students, led by Assoc. Prof. Dr. İrfan Deniz Yaman. 

 

PHOTOGRAPHY TECHNIQUES 

The explanations to be presented regarding photography techniques used in the field of archaeology will 

be given in a specific order. In this context, it is necessary to mention the light sources used in 

archaeological photography, as in every field of photography. 

 

The Use of Light in Archaeological Photography 

The aesthetic effect of light in a photograph is certainly among the issues that artists value. Although 

light is fundamentally divided into the basic categories of natural and artificial, it has also many different 

types in terms of its effect in a technical context (Yıldırım & Nuhoğlu, 2024). Being able to take 

photographs by using the intensity and direction of different artificial lights in a studio environment is 

related to the technical competence of the photographers. In natural light conditions, the photographer's 

ability to read the light and adjust their shooting plan accordingly will be only possible for an artist with 

many years of experience. In this context, in shots taken with natural light, the correct evaluation and 

control of the direction and aesthetic effect of the light is of critical importance to achieve successful 

results (Kanburoğlu, 2012, p. 180).  

 

In this study, "natural light" was used for photography of the excavation site and its surroundings, while 

"artificial light" (Godox Led 6R RGB Led Video Light) was used to photograph the artifacts. This 

particular model was chosen for its use in artificial lighting because it is both easily portable and has an 

adjustable Kelvin temperature range between 3200 and 6500. The first group of artifacts photographed 

at the Keçe Cave excavation site consisted of chipped stone tools. Numerous factors influenced the 

photographic process for these artifacts, including the type of stone used, stone colors, technological 

characteristics, and fragment thicknesses. In this context, it is important to emphasize that the techniques 

used to photograph the selected chipped stone artifacts may vary for each piece. The chipped stone 

artifact was photographed with partial frontal lighting, and a silver reflector was used to illuminate areas 

that remained in darkness. Since the large size of the artifact would affect photographic clarity, the 

"photo stacking technique" was applied. The steps involved in applying the photo stacking technique 

(which will be described in a separate section) are as follows: two photographs were taken from each 

side of the artifact. In Photoshop's Camera Raw settings, the amount of light was increased by 

realistically adjusting the exposure and shadow settings, while the highlights and white balance were 

decreased to avoid glare. Vibration and saturation were negatively adjusted to bring the color balance 

closer to the original. Texture and sharpness settings were also increased to highlight the details on the 

artifact (Shutter speed 1/250, Aperture f/5, ISO 500) (Figure 3). 
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Figure 3. Chipped stone tool.  

 

 

For the image of the jawbone, side illumination was favored. The LED light was adjusted to a yellow 

hue to enhance the visibility of the bone artifact, with its brightness finetuned according to the piece. I

n Photoshop's Camera Raw filter, the exposure and shadow levels were raised to amplify the light, acc

urately mirroring the original scene. Vibrance and saturation were reduced to achieve true color fidelit

y. Texture and sharpness were heightened to emphasize the intricate spongy details of the artifact (Shu

tter speed 1/125, Aperture f/8, ISO 500) (Figure 4). Regarding the shot of the animal's tooth, side illum

ination was also employed. In Photoshop's Camera Raw filter, the exposure and shadow adjustments w

ere increased to boost the light, while highlights and white balance were toned down to prevent glare. 

This resulted in accurate color representation (Shutter speed 1/100, Aperture f/5, ISO 250) (Figure 5) 

 

           
           Figure 4. Animal jawbone.                                                     Figure 5. Animal tooth. 

 

To capture the ceramic artifact, side illumination was utilized. In Photoshop's Camera Raw settings, the 

exposure and shadow parameters were heightened to faithfully represent the artifact, while highlights 

and white balance were reduced to eliminate glare. Vibrance and saturation were lowered to adjust the 

color balance to its original state. The texture and sharpness levels were enhanced to accentuate the 

artifact's intricate details (Shutter speed 1/80, Aperture f/5.6, ISO 400) (Figure 6).  
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Figure 6. Pottery piece. 

 

The metal artifact was captured byusing side illumination. Within the Camera Raw filter of Photoshop,

 the exposure level was elevated to accurately depict the state of the artifact, and the saturation was pos

itively enhanced to better reveal the hues of the corroded material. Adjustments to texture and sharpne

ss were also made to emphasize the intricate details of the artifact (Figure 7: Shutter speed 1/100, Aper

ture f/5.6, ISO 400), (Figure 8: Shutter speed 1/100, Aperture  f/5.6, ISO 320) (Figures 7-8). 

 

                                                             
                    Figure 7. Metal artifact.                                      Figure 8. Metal artifact.                                       

 

 

Side illumination was employed for the micro-find photography. Given that the artifact was measured 

less than 1 cm, a macro extension tube was utilized during the photography session to better capture the 

intricate details. Thanks to the macro extension tube, our standard lens enabled us to close in on the 

finds with nearly macro lens quality, thus allowing us to document all the features of the artifact despite 

its diminutive size. In Photoshop's Camera Raw filter, the exposure and shadow adjustments were raised 

to boost the luminosity, while the highlights and white balance were decreased to minimize glare. 

Vibrance and saturation levels were positively adjusted to restore the color balance to its true state. 

Texture and sharpness settings were also heightened to accentuate the details on the find (Shutter speed 

1/30, Aperture f/5.6, ISO 500) (Figure 9) 

 
Figure 9. Stone beads. 
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For the glass artifacts, lateral illumination was used, with black cardboard positioned on each side. This 

black cardboard, reflecting its own light, generated a dark line along the edges of the glass artifacts, 

enhancing their definition. A polarizing filter was also implemented to mitigate light reflections. Within 

Photoshop's Camera Raw settings, exposure and shadow adjustments were increased to optimize light 

intensity, while light tone and white balance were reduced to avert glare. Vibrance and saturation settings 

were adjusted negatively to restore color balance to its original state. Texture and sharpness settings 

were enhanced to render the artifact's details more prominent (Shutter speed 1/160, Aperture f/5.6, ISO 

500) (Figure 10). 

 
Figure 10. Glass artifact pieces. 

 

The photographs of the artifacts were taken by using a setup made of two LED lights and a reflector, 

without relying on daylight. The values set during the photo shoot were determined specifically 

according to the size and shape of the artifact. As a basic setting, the aperture was adjusted first, and the 

ISO and shutter speed were then adjusted accordingly. For large artifacts where stacking techniques 

were applied, a low aperture setting such as F5.6 was used as several photographs were needed. For 

larger artifacts (flatter, with fewer indentations) where this technique was not necessary and only one 

photograph was taken, the aperture setting could be increased to F8-F11. For smaller artifacts, an 

aperture setting of F5-F5.6 was ideal. This prevented blurring that might have been caused by a low 

aperture setting, and it also disabled the light loss that might result from a high aperture setting.  

 

Following the photography examples of the Keçe Cave artifacts, the panoramic photography technique, 

HDR photography method, and Focus Stacking technique—central themes of this study—will be 

elaborated upon with examples.  

 

Panoramic Photography Method 

Large-format images and digitally enhanced panoramic photographs are garnering interest both as a 

commercial product and as a powerful visual medium in the realm of photographic art. The foundation 

of the large-format visuals that captivate us today is rooted in the art of panorama execution, which 

originated in 1789. The Diorama displays pioneered by Daguerre in 1821 not only hold significance as 

a performing art but also, they present the inaugural examples to utilize large-format photographic prints 

in exhibitions. The demand for – and appreciation of -large-format visuals has evolved alongside the 

growth and dissemination of photography. Cameras designed to capture this expansive image as a formal 

and accurate representation in a single shot are referred as panoramic cameras. It is also feasible to create 

panoramic images without employing a panoramic camera. Özdal explainsthis method in the following 

statements:  

 

1-As initially demonstrated by the daguerreotypists, the technique of merging photographs captured 

from specific points along a direct line parallel to the landscape is essential. For the photographs to 

merge accurately, there must be overlapping images between each subsequent photograph taken. By 

layering the same visuals, the image can be extended without distortion or displacement. 

  

2- Similar to most automatic or digital cameras in use today, the captured image using a wide angle of 

14-28 degrees is cropped at the top and the bottom to create an impression of a panoramic image. 
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3- It is possible to generate panoramic photographs with digital cameras and computer-aided 

applications. Software available for download from the internet or photo-stitched programs included 

with digital cameras greatly simplifies our tasks (Özdal, 2008). 

 

Capturing images of the work area is crucial in archaeological research. Photographs of the work area 

can be taken to showcase the entire site, as well as detailed areas such as close-ups of the excavation 

site. Panoramic images are utilized in archaeology to depict where the work is being conducted and the 

extent of the area it encompasses. With the advancement of technology from past to present, such images 

are now primarily captured using unmanned aerial vehicles (drones). In fact, not only photographs but 

also 3D scanning models have now become part of this framework. Despite technological advancements, 

an example will be provided within this study for archaeologists who operate under constrained 

conditions or who wish to create panoramic photographs using alternative techniques. 

 

This method was used to obtain general photographs of the rock paintings and the cave as well as its 

surroundings. Panoramic photography of the rock paintings is essential as all the shapes and symbols 

can be perceived as a complete whole. Taking an overall view of the cave utilizing the panoramic 

photography technique is essential to showcase the entire area encompassing the Keçe Cave. Employing 

a tripod is necessary when capturing panoramic photographs. To photograph the Keçe Cave, a setup was 

formed at a hill across from the cave, which is approximately at the same elevation as the cave. The 

following steps were followed during the photography process: 

 

Step 1: The camera display was adjusted to the 9-segment grid setting (Figure 11). 

 

 

 
Figure 11. Grid adjustment appearance on the camera screen. 

 

Step 2: Reference points to create intersections were established (Figures 12-13). 

       
Figure 12. Photo 1 The reference point.                                Figure 13. Photo 2 The reference point. 
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Step 3: Six photographs were taken based on the reference points (Six photographs were captured for 

the study, but this number can be increased depending on the area and subject being studied) (Figures 

14-16). 

 

 
 

Figure 14. Photographs 1 and 2 were taken as panoramic photography. 

 

 
Figure 15. Photographs 3 and 4 were taken as panoramic photography. 

 

 
Figure 16. Photographs 5 and 6 were taken as panoramic photography. 

 

The steps to be executed in Photoshop are: 

Step 1: File > Automate > Photomerge (Figure 17). 

Step 2: Auto > Blend Images > Browse (Figure 18). 

 

            
    Figure 17. Step 1.                                                                   Figure 18. Step 2. 

 

 

 

 

 

Step 3: Select photos using Ctrl (Command) > Open (Figure 19). 
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Step 4: OK (Figure 20). 

     
            Figure 19. Step 3.                                                         Figure 20. Step 4. 

 

Step 5: Select photos using Ctrl (Command) > Merge (Figure 21). 

Step 6: Trim edges, adjust color settings (Figure 22). 

      
              Figure 21. Step 5.                                                                        Figure 22. Step 6. 

 

The outcome after systematically following all the steps is illustrated in Figure 23.  

 

 
Figure 23. Panoramic technique final version. 

 

HDR Photography Method 

HDR (High Dynamic Range) is a technique that harmonizes various lighting values to ensure that every 

area within the image (whether in shadow or light) is perceived in an optimal way, free from 

overexposure or excessive darkness, by expanding the dynamic range with the assistance of software 

(Kanburoğlu, 2009).  

 

This method is utilized to capture a harmonious and high-quality photograph, particularly in regions 

where shadows and highlights coexist. After making the necessary adjustments to the camera settings, 

the shutter button is pressed once to capture a series of images across the determined dark and bright 

exposure ranges. These images are subsequently merged in Photoshop by following the required 

procedures to create a well-balanced photograph. 

This method is regarded as highly advantageous in fieldwork, especially at archaeological sites, as it 
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enables toovercome the challenges posed by natural lighting. 

 

Camera Instructions: 

Step 1: Menu > Shooting Settings > AE Bracketing Adjustment (Figure 24). 

Step 2: Frame/Step Configuration (This setting should be modified based on the number of frames and 

the intervals at which pictures are intended to be taken (Figure 25). 

  

                           
            Figure 24.  HDR technique, step 1.                         Figure 25. HDR technique, step 2. 

 

Step 3: 1 Frame/Continuous > Continuous (Figure 26). 

Step 4: Sequence > - 0 + (negative, zero, positive) (Figure 27). 

 

                             
       Figure 26. HDR technique, step 3.                                   Figure 27. HDR technique, step 4. 

 

 

Photoshop Instructions: 

Step 1: File > Automate > Merge with HDR Pro (Figure 28). 

Step 2: Browse (Figure 29). 

 

      
              Figure 28. Photoshop, step 1.                                     Figure 29. Photoshop, step 2. 

 

 

 

 

Step 3: Select images with Ctrl (Command) > Open (Figure 30). 
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Step 4: Attempt to Automatically Align Source Images > OK (Figure 31). 

 

       
           Figure 30. Photoshop, step 3.                                              Figure 31. Photoshop, step 4.  

 

Step 5: You can make modifications according to your individual preferences at this stage. (Figure 32). 

Step 6: Save (Figure 33). 

   
             Figure 32. Photoshop, step 5.                        Figure 33. Photoshop, step 6. 

 

The outcome is displayed in Figure 34.  

 

 
Figure 34. HDR technique final version. 

 

Focus Stacking Technique 

Small objects are frequently found among archaeological finds. The recording of various structures and 

archaeological finds within the scope of cultural heritage by using advanced digital imaging systems is 

increasing day by day. However, some technical difficulties are encountered in the process of digitizing 

small objects. The most common problem in macro photogrammetry is related to depth of field. At high 

magnification levels, a small depth of field can disrupt image alignment or create problematic areas. It 

can also significantly reduce texture quality by creating blurry areas during the photographing phase. 

The proposed solution here is the Focus-Stacking technique (Marziali & Marziali, 2019). 

 

 

Focus stacking is a photographic technique that consists of capturing a stack of images at different focal 
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planes for each camera exposure. This is the only solution to overcome the problem of short depth of 

field. The movement of the focal plane between various shots can be achieved in two different ways. 

One is: fixing the camera to a tripod and manually or automatically changing the focal plane with 

software while the other method is to hold the focus lens fixed and move the entire camera/lens system 

on a micrometer-sized slide, which moves the focal plane as well (Clini, Frapiccini, Mengoni, Nespeca, 

& Ruggeri, 2016). 

 

In this technique, multiple photographs are taken by focusing on different points of the find and then 

one can combine them in Photoshop to ensure that the entire find is in focus. Depending on the 

characteristics of the photographed piece, sometimes it is possible to apply this technique with two 

photographs, while in some pieces this number can reach twenty. In this study, the photo stacking 

technique was used, especially in profile photography of large-sized stone finds. The photograph 

shooting stage and Photoshop processing sequence are as follows: 

 

Step 1: Taking photographs by focusing on different points in a way that complements each other  

Note: Here, the areas inside the circle are not in focus. The areas outside the circle are in focus (Figure 

35).  

 

 
Figure 35. The appearance of photos. 

 

After taking a photo, the processes in Photoshop are as follows: 

Step 1: File > Scripts > Load Files into Stack (Figure 36). 

Step 2: Files > Browse (Figure 37) 

     
         Figure 36. Photoshop, step 1.                                            Figure 37. Photoshop, step 2. 

 

Step 3: Select photos with Ctrl (Command) > Open (Figure 38). 

Step 4: Try to Automatically Align Source Images > OK (Figure 39). 
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        Figure 38. Photoshop, step 3.                                             Figure 39. Photoshop, step 4. 

 

Step 5: Select photos with Ctrl (Command) > Edit > Automatically Blend Layers (Figure 40). 

Step 6: Stack Images > Seamless Tones and Colors > OK (Figure 41). 

     
            Figure 40. Photoshop, step 5.                                   Figure 41. Photoshop, step 6. 

 

Step 7: Select and Merge Photos (Figure 42). 

 
Figure 42. Photoshop, step 7. 

 

The result after following all the steps is shown in Figure 43. 

 
Figure 43. Photo stacking technique final result. 
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CONCLUSION 

Photography has always been a cornerstone of documentation during archaeological surveys and 

excavations carried out in the field. It is essential to capture the progression of an archaeological 

endeavor from its onset, including the images of the sites, the research team at work, and the artifacts 

discovered. Prior to the digital camera era, photographs taken during research could only be viewed 

post-printing, which meant only certain team members had access to cameras. This scenario has evolved 

to a considerable degree with the rise of digital photography and its wider accessibility. Although each 

archaeological project operates with its unique dynamics, in general, archaeologists have become more 

adept at photographing their own endeavors. While photography is a professional requisite, its 

perception varies significantly among those who pursue it as a career or an academic interest. Field 

archaeologists and professionals from similar disciplines primarily photograph with intent, aiming for 

images that align with their objectives, such as illustrating the research area, capturing team members 

in action, and documenting specific discoveries. Each image included in these categories must exhibit 

particular attributes. For instance, a wide-angle shot is essential for portraying the worksite alongside its 

context. Additionally, there are critical considerations, such as selecting the right lens for the intended 

purpose. In the current era, one can explore various documentation techniques, ranging from 3D 

scanning to aerial photography via drones. Nevertheless, even with the utilization of cameras in 

archaeological endeavors, traditional drawing methods remain popular, and despite modern 

documentation advancements, photography still continues to be a fundamentaltool. 

 

This article offers practical advice especially for those who are engaged in any archaeological endeavor 

and who possess basic photography skills. It provides in-depth information on the most formative 

aspects of the discipline together with its major challenges. Currently, panoramic images are often 

captured using drones. For those lacking this capability, or in circumstances where drone operation is 

hindered by weather conditions, methods for creating similar images with a camera are delineated. The 

HDR technique discussed previously is acknowledged for its capacity to enhance the quality of 

photographs, particularly since most archaeological work typically unfolds in outdoor environments. 

Lastly, the photographic stacking method, which is introduced as a remedy for the clarity issues related 

to depth in artifact photography, is elaborated upon. Practitioners employing this technique can 

effectively document artifacts with optimal clarity.  

 

Archaeological projects, particularly excavations, involve a timeline stretching over several months. It 

is impractical for every excavation to have a professional photographer present throughout this entire 

time period. Therefore, essential techniques in archaeological photography, often conducted by 

knowledgeable and seasoned team members, have been highlighted. The core objective of this study is 

to provide recommendations to enhance the quality of photography within archaeological projects. We 

vision that in the forthcoming years, more comprehensive solutions can be formulated through 

collaborative efforts between photographers, academics, and archaeologists. This study is also expected 

to act as a catalyst to bring out new research that orients itself around such interdisciplinary approaches.  
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